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NOTICES

* Before starting your application, please review our “Initial Application Required Documents Guide" for instructions on how to prepare for your online

Some other helpful information can also be found by clicking the "Application Info" link at the bottom of this page.

* For applicants applying through an official recruitement Agency or partner MOU/MOA Organization, please consult directly with them before starting your ap

* Keeping the application open and idle for extended periods of the time may result in your session timing out and data being lost.
* Please send any inquires to Epik@korea.kr.
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Begin Your Application Review and Print Your Application

Collection and Use of Personal Information

— Personal information collected will be uged for its intended purpose only - processing your application,

— Only required information will be collected, including: applicant's name, address, phone number, mobile number, and email address,
Optional Information: Some of the above may be optional,

— Collection Method: G Application

— Use and Retention Period: Any information during this process will be destroved once it is deemed unnecessary.

Do you agree to submit your personal information under the terms
and conditions listed above?
@ldo Oldont

CLICK
THROUGH
AND
AGREE

Handling of Personal Information by a Third Party

= We commission the handling of applicants” personal infarmation to a third party as part of the application process and enforce requirements to ensure that
vour personal information is handled in a secure manner in accordance with the relevant laws and requlations.

Entrusted Task:

Third Party Handling Personal Information

Commissioned Duties

Receiving & Processing

JinnakApply Corp. Application Forms

Privacy policy of Jinhakapply

Personal Information Retention & Use Period

Until the intended purpose has been accomplished
or until the end of the commissioned period.

Have you read the above information?
@ | have read the above information.

CLASSIFICATION

* CLASSIFICATION

() Direct Applicant () MOU @) Agency

() Korvia Consulting
() Korean Horizan
() Reach to Teach

* MOUfAGENCY () Goldkey Education

HECK HANDS
KOREA

(@) Hands Korea
() Canadian Connection
() ESL Consulting




PERSONAL INFORMATION

L&ST MakdE(S) © | POTTER

* NAME FIRST NAME(S) : | HARRY MIDDLE MAMELS) : | JAMES

[Jcheck this box if you have ever received a legal name change.

Include any suffis (r., Sr., etol,

TEAR | 1987 | MONTH 01| DATE |01 [{ex! Y'Y

* DATE OF BIRTH
AGE |52

* BE¥ ® Male (O Female

+ MARRIAGE () Married (@ Unmarried COI { I ‘ I : ;I O N D I N G
CITY, STATE/FROYINCE @ | LONDON

INFORMATION
COUMTRY | UK

* PRIMARY United Kingdom v|

CITIZEMSHIP Select the citizenship vou will use to teach in Korea
SECONDARY
CITIZEMSHIP

List any other citizenshipis) vou hold.

- Are you ethnically Karean?
) Yes (@ Mo
[(J=heck this box if you @ STHARD| S T2 4O NISHHESH0| - Internet B, — X

oS vlE

* KOREAM HERITAGE

YEAR | 1987 | PMOMTH @https:-'-'u|'|i'-,'.jinhakapply.cnm:‘.ﬂppl';."v'E-";".'n::n:En::-'SE.al'n:hF-JEﬁ--'Phn::tn::-'Pn::pPhuﬂ
AGE T |32

w0 Mhale (O Female

(3 hdarried (@) Unmarri

CITY, STATE/PROVINCE

COUNTRY + | LK

United Kingdom

Select the citizenship vo

List any other citizenshid

- Are vou ethnically kore

UPLOAD
IMAGE

GRO

CROP IF

NECESSARY
(PHOTO BACK-

UND MUST

BE BLANK)

Pleaze upload
vour phaoto file

|~ | REGISTER

Click here if uploag
system is not worlg

- .-‘-_""\
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0 Blank X Zize X Blurryx ZCEneny
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YEAR 1987 | MONTH |01 | DATE |01 |[{ex: ¥y%Y /S MM /S DDY
* DATE OF BIRTH

AGE: |32
* SEX @) Male () Female
* MARRIAGE () Married (@ Unmarried

CITY, STATE/PROVINGE @ | LONDON

con: i SHOULD

* PLACE OF BIRTH

* PRIMARY United Kingdom
CITIZENSHIP Select the citizenship vou will use to teach in Korea. LOO K I I I I f ;
SECOMNDARY

ClulzEls Ly List any other citizenship(s) you hold, WAY

- Are yvou ethnically Korean?
() res (@) Mo

* KOREAN HERITAGE

[MOTES ON UPLOADING ¥OUR PHOTO]
v Thephotomusthavebeentakenwithoutcaps,hatzorsunglasses andwithinthree
months fraomthedateofapplication,

Fleasedonotusephotozwithbackgroundscenery orthatare toosmallto distinguizh
clearly,

» Photo must be 3cmiin width) % dcm{in length).
+ JPG,JPEG, PNG, BMP, GIF Images only. 2MB Limit.

] Acceptable Unacceptahle
Upload Photo

* PHOTO

Click here if uploading
system is not working

il
o] B lark Size X Blurry SCenen X
TAKE EXTRA CARE
THAT YOU HAVE
PUT DOWN THE
RIGHT TIMEZONE
Available interdew start ime=+ Tues, Thurs, Fri 16-17KST Slevpe 1D (Required) live harry_3
Frimary Phone (+ Country Code) +44 00 CO00 0000 Secondary Phone (+Country Code) + 020 1111 1111
* INTERYIEW COMTACT
INFORMATION Prirnary Email realharryp@gmail, com Secondary Email harrypotter@hogw arts, edu

== Interews are scheduled according to Korean Standard Time (KST), Start times are available Mon to Fri from 02 00-17.00, List all
available interew times (g,0,, M-F, 1330-18:30KST), Failure to list tmes will resultin delays in scheduling,

* TIME SPENT ABROAD Do wou currently or have vou ever lived in a countrythat does not correspond to the primary citizenship

listed in the "PRIMARY CITIZENSHIP" section? If wves, list below: o
List vour primary mailing address, Flease notify vour EFIK Coordinator, Recruitmant 8gency, o MOUMCE Crganizaion of any address
changes.
HOUSE NUMBER & STREET MAME CITY STATE/PRCVINCE POSTAL CODE CCUNTRY
* MAILING ADDRE S5
and PHOME NUMBER 4 Privet Drive Litle Wwhinading Surrey WOE 2DR Lnited Kingdom

TELEPHOME (IMCL, CCUNTRY CODE & AREA CCDE)

4020 1111 1N

List contact information for a family member in case of an emergency,

* EE)HIETF*A%ETNCY FIRST NAME LAST MAME RELATICH HOME AMCBILE PHOME {+ COUNTRY CODE)

Rubeus Hagrid Guardian +4 00 1234 BET2



EDUCATIONAL BACKGROUND

Far educational background, list all primary and secondary institutions in the arder attended. For tertiary education, list each
(including transfers, etc.). &l institutions attended where credits toward a final degree were awarded must be listed,

INPUT

«-{ CORRESPONDING

+ EDUCATIOMAL SCHOOLING MAME OF INSTITUTION CITY & COUNTRY
BACKGROUMD(1)
> Add Primary Whinading Primary Sch Little Whinding, Uk 09|/ 199 I N FO R M n T I O N
* EDUCATIONAL
BACKGROUND(2) Middle Hogwarts Schoal of Wi Leavesden, UK 09|/ 199
*> Add » Delete
FROM TO
MAME OF INSTITUTION CITY & COUNTRY MMATY ) M) YE&RS AT SCHOOL
+ TERTIARY(1) University of Magic Leavesdan, LK 03/ 2mn og |/ | 2mg 5
> Add
DESREE: Bachelor MAIDR: | Wizardry Overall Grade! |28 / 4
Put your final or current GPA, percentage (ex 57%),
Leave next section blank if wou have vour diploma, i you do not, when will v I N PUT grhgsun&r; grgc?:(oeﬁlygur) sl;glgglosl‘ip:g:lé?ei ma.u;,}d.ﬂ
or 8.3/12.0), For applicants whose grade are
percentages orin a different farmat pur vour overall
OVE RALL G RADE IN grade as listed by vour school (ex 65% or 211 or 15t
CERTIECATON PERFERED FORMAT |l
TITLE OF CERTIFICATION FROGRAR MAKME OR 155UIN
CERTIFIC ATION{1) Hours Haours
> Add lssue Date In-class | Onling
TEFL/TESL/TESOL English Teaching scademy
2019 | S | /|20 20 10a
JOB TITLE EMFLOYER COUNTRY FROM: BARAS STATUS
duror tinistry of Magic UK or| /| o0t Full Time
CURREMNT
AGE RANGE OF CONTRACT END DATE
EMPLOYMENT SCHOOL NAME SURIECT
IF THIS JOB IS A
TEACHING POSITION: I N P l 'T
SCHOOL NAME TITLE COI “ {ESPONDING
TEACHING
== | INFORMATION
> Add
FRCIA: BaAhd / TOw hbd
List contact infarmation for teaching experience in KOREASincluding Talk), Other school details must be listed in the appropriate
section above,
CONTACT MAME OF hAall
INFORMATION(1) SCHOOL MAME OFFICE PHORKE ERAIL
Y CO-TEACHER / DIRECTOR

* ORIENTATION

NOM-TEACHING
WORK EXPERIENCE
{12

> Add

* SALARY LEVEL

Have vou ever taught in Korea through the EPIK program before?
Have you ever atended an EFIK orientation? () ves (@) Mo

A

(O ves (@ Mo

TITLE EMFLOYER COUNTRY FROM: RABSYSSY TOD MRS STATUS
/ / select...
he EPIK pay scale can be found at the i " iption Flease select the pay level t

at vou currently qualify for AND the final level for which vou will qualify,

: !‘EVEL : LEVEL 2 LEVEL 2+ LEVEL
(beginning salary level) (top salary level)
CURRENT QUALIFICATION @] ® O @]
EXPECTED QUALIFICATION @) @] O

VISIT:

https://www.epik.go.kr:8080/contents.do?contentsNo=49&menuNo=278

TO CHECK YOUR LEVEL




APPLICATION INFORMATION

JOINT APPLICANT
OR DEPENDEMNT{1)

> Add

* PLACEMENT
PREFERENCE

* 3TART
PREFERENCE

ILE UPLOAD

INPUT
CORRESPONDING |*
| INFORMATION

Applicants should ultimately be flexible about warking anwwhere in Korea, If vou have a specific preference for placement, please select th
ocation below. Final placement in that location cannot be guaranteed,

Select Your Preferred Placement Location  |Flexible

vour preferred placement lacation will be taken into consideration: however, final placement will ultimately be decided on
a variety of factors including availability, the zpecific needs of the offices of education, and the discretion of the EPIK
Fragram, etc.

Mame Joint

The majarity of the positions are far the February main intake. Late intake positions start in March and April,

- My ideal startind date i= |February Only (Main Intake)
-If you do not secure a placement this term, do you want to be notified of application for Fall 20207 @ YES (O WO

* RECOMMENDATION
(1)

* RECOMMEMNDATION
(2)

Current Contract

Proof of Enalish
Education

Applicants must submit 2 letters of recommendation, Please visit the "Apply Now” page of the EPIK website for details,
> View Upkaded File > Upload File

applicants must submit 2 letters of recommendation. Pled
> ¥iew Uploaded File » Upload File

MUST UPLOAD 2 LETTERS
OF RECOMMENDATION
(ONE FILE PER FIELD)

If part or all of vour education was conducted in South &) rea
within one of the zeven designated countries where Enalish is not the primary language of instruction for schools, please submit proof of
English education for all schools attended from 7th vear/grade and before entrance into univeristy, Please visit the "Apply Mow” page of
the EPIK website for details,

> Upload File

Current teachers in Korea must submit a scan of the pag
page of the EPIK website for details.

> Upload File

L EPIK

Bagin Your Appifeation

Guast English Teacher Recruiting

Raviaw and Prist Your Appleation

CLASSIFICATION

AFTER PRESSING
‘PROCEED’ ALL
APPLICATION SECTIONS

PRODUCE A COMPLETED
VERSION OF THE SEC-
TION.

PLEASE DOUBLE CHECK

THE APPLICATION AT THIS
TIME.




ADDITIONAL PERSONAL INFORMATION
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=h tha languags of instruction Tom Tth grede through university mnd were tha schools located in one of the saven cesignated
wa hirg from or, if not, were they scorecited indarmetonal schools taught prirarily in Erglish?

@ YE3 I ND

Hesva you

ewar frminated sny lmeching conract?

() YER (@ ND

tandard sadobs pisrcings, do you have ey other pisrcnga?

O YES @ ND

Do you henea &y Satinos? [

() YES @ NO

Hevra youw

[Alcchol and drug-relatsd ofen=e= arg ncluded.}

ACKNOWLEDGMENT OF EPIK POLI

=, ba spacific and indicak sizgl

evar bean charged [whefher convicied or dismiz=ed

FILL IN
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Ara

unclaratand et docurmants submitied fo EPIK will ng
unoaratand et | may be sxpaciad o plan las=sons

CHECK ALL

will notify EPIK if | dacide to withdraw from the progr]
o ranpply for 1 year and thet | must retum all dacurs

mm preparad o bring tha aguivalant of 1,000 LED 5o

unocaratand fet tha apecific achoal location, ypa, o
POEfMW OE and that #his irformaton will nat be provid|

EPIK POLICIES

TRUTHFULLY AND

under=tand that my final placemant mey wlirmeely be with eny ofice of sducefon, and | understand that plescsmant i= not gusaneed
until inal accapiance by an office of sducaton following docurent submiz=ion

unoaratand commuting e may vary and somatires be upward of 80 minuias.
undarstand #iet ms an EPIK macher, | mm not allowed o have mny pets whils ra=iding in Koraa.

mm pwens ol if | break orienmion rules such a= binpng/drinking alcohol insice fie dormicrie=s/ facilita=, baing tuant fom eny schecu led

actvitas miing curfew, ar parforming conchuct unbacoming of en EPIK teachar my conract will be mrminamd and that | will basr tha

caoats of lkeeving Forea

b 5 . -
o A0~ | unclarstand fiet all =uccas=ful sppliceants rmust akos & meadicel sxam in Kores in sccordance with the mequiremarts of tha EPIK program.

Hewi
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o |-
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o}

Do | |43
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Do | |ge-
(8R!

On

f e rasule show that the applicant i= undt o ba an EFIK macher, all costs for entry, sy, and caparture will ba bome by ta EPIK
mpplcant

unoaratand $et tha orisntafon is mendatory for all applicants including fiome wha heva completad arsntation praviou=ly. | under=tand
that it i= my mesponsibiliy o en=uwse that | plan accordingly =o that my =chadula doa= nof confict with my oblgefon o mtend onenbon.
Failure to atiend tha orientasion mayr ra=sult n the sminaion of my conract offer.

will immadiatsly indform tha EPIK office of any chengs to ry health (=urpary, pregnancy, injury, edditonal prescribad medicasion, atc.]
or of ary new fatoos or piarcirg=s Hat pe obimined efier =ubmia=ion of fhis applicaton. | undersmnd that thi= inforrason rust be =hanred
with EPIK within 24 houra and that if | had racaived a placament at fist §me, it ey ba ground= for resvaluafon by my POE/MOE.

will kaap all milocs covared and ramrove all non—=ianderd piscings when n any ecucationsl or poof
tnoca will not ba 3aen by any student, educatoe, inafuckor, =uparn

onal se®ng. | will en=ure that
=ar, or othar individual as=ocimiad or efiliasd with ry sducaions!

natitufian or Cfice of Educetion. | will sccept army conzapusnces for tha failurs o do =c.

will not smcks on =choal ground= or af ey school funcon. | endarstand et | ray be prohibited from =moking in=ide $he =choal providad
heowairg and will sbida by the rulas of the housing™ landlord. | will refemn from =moking in public arass whems here i1 8 reascnable
chenca that | rayr ba ssan by student= ar co~wadeara.

unoaraband hiet if | have any depardsnt= $et will accompany re o Korea, | am e naile far all rafers concerning thoae capardent=
much a= vims issuarcs and fat EPIK dogs not provids amy sotrm masistance or banafits in ragerds i housing consideratons, ai.

Ve penmiasion o the Mational Inatiuie for InEmatonal Educetion and all afilisad organizations o uze s wmail contectE providad in
thi= application for fhe purpasas of communication, providing information, conducting surveys, snd aic. a= neadked. | giva authorzeton far
phioios. and widea of ma o ba aken during the orientafon paricd and u=ad in any promotional or educebonal maknsl.

haraby suthoriza the Engh=h Program m Korae K] o venfy fhe inforrafion ci=clo=ad in thia sppliceton fomn and tha documants

raguired by EPIK ma will a2 o collect amy othar irformaton desmed nacesaar by EPIK fo delerming my suniakbility e= an applicant from

FILL

n. Thia includes buti= not liriad %o conecEng

IN FULL NAME [-oos e

will ba limied 1o EPIK =taff and

AND CURRENT DATE [zimmmmmm

- ~ ~ - mnetion of rmy confract ofer

HARRY J PCTTER 2ne
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. - . e N . . . .
Aeneen wivema sodeles augue nec loborti=. Pellant==gue habifant morkd Fisbigue senecius et pehes =i malesuads fames ac wrpis egesias. Nunc su riswes pheretra, ali

guam sugus eu, wehicula eros. Morbi woluipat nisi id pulvinar portiitor, et negue dapibus liguls, =get fermentum velit nibh ron nisi. W digni=z=im sagits lacus dagi
us fnjbus. Dui=s segiti= it o, ot imperdiet velit uliicies =t Hullam =mpu=, qulla in =olliciudin dapibus, ame fodor tempor justo, o solliciudin sem ant= guis st
Wmecenss Encidunt guiz pibh =t commeda, Phesslus melsste, aisi vise yehisuls scelerague, orc nisl Feilisiz wme, guis eravida grei dui ac ypa, In

aagisn ni=i. fiogla nes insrdvm. cendimenbim, wum, nes ez Yimmen iRsuliz nizl =it amel posvers inciduok Ged conmaaunt ac fiberoympius porfiies Mayrs o

< ant= igiagvme Wiicea sk, pdnme oo, Bhassibe necumaso s lreus, v canasciei. Bmin auis, convallis gupm, id gaeaies, mis, Duis yel miatgmb il
H;i;'g'_vs_wdiclum EEQ—?—EE'.M ﬁg_r:l_ neque urne, aui=mod Ea_at_htndtrit nan, mmﬂﬂgnﬂ. Me ol '_{_ELM'I‘M hendrasit E‘i_:"_:vl_h_rﬂ'_lnn:rn igulls, E—':'-F.'-!-IE'-HF-

uliices =ed, finibus eget pulla, Meaecenas comaeguat, eatid omere.

% Thiz Em=mey i= 300 Ward= long.

* Plaase sxplain your teaching phil osophy.

[

bulum ulir ria guam at lnon=et tincidunt Cras iaculis veries lacus, vanu

—1 WRITE PERSONAL ESSAYS [

jgue sed, loboris =it gmet mi. Mullam commode, elit zed 30

o AS INSTRUCTED. P

Eakam. ses) Imgue sy, nisi guinmed mateauade, Guizgus non gps, come

c==l  *PLEASE REVIEW AND s osssssss cosmmcnnas
"= MAKE CERTAIN THERE [r e oo o e

ghum, Mung AR E NO TYPOS # This E==ay iz 300 Wards long.

* Bhare |

\ivamus ey meona suizmod, wieuisie libero gy, semper mazsa. Maecenes juzio metus, blandit =c fizfoue sed, lobedia =it smetmi. Hullam commede, elit zed zoll
isiiugin acelsrizous, nune eit kmear acsy, Rt asdeles iwllus, sme Wlsmesmer dui. Benec impardiat nisl gl lorem fpmper. & voludpat il eslsnizzque. Guspendinas o,
mntumsun rufum. i orbi Mpha'\eh‘u ligla, EEIium cmsegunt mmﬂ:‘ﬂﬁ. Muim %mnisi euinmaod malesuade  Quisque non ergs come
liz, Bncidunt mi =it amet, blandt lacus. Donec vel placemt megna, =it emetiaculis nibh, Meuris vi=e odic ot negue imperdiet placerst Cra=s scelerisgus conseguata
ugue, ac fBcilEmE diam.

In zgetvelit ol Euscs eficihie tores quiz imesedist bengrert ansen pora sepien nen lephus placemt vlirices. Nunc non ylamoorper megna. e vilse mitum, m,
sz, Munc ac.¥Vivemus gy megna gui=med. wiewabks libero g4, semper mazze, Mascenss ysie mehs, baodi ec Dok, sed, Iebodiz =it amet mi. Bullam semme.
do, elit =ed solliciudin scelerizgue, nunc =fit empor arcu, 2g=t =odeles fellus =ro= ullamcorper dui. Donec imperdist nizl ut lorem temEeor, & voluipat =it pellent==gu

et mm e

. - N . . . . . L .
£ Bumpendis=e prefium sccums=en rufum. M orbi hmE_-_gr pharatre liguls, EEhurn con=segust melus mollis nec. Mauns vime Iscus eu nisi muinmod makesusde :lumg

| s non mroe Coergmllie fincirbint i et smet Blmodi s . 3 % i A L o o F R -
¥ Thi= Ezzay i= 128 Words long.

* QUEBTIONNAIRE

Howr oiid you laarn aleout the EPIK Program? Balact a= many as applicabla.

EFFII-{ Horre paga DEF"IK s—Fra== DF"iand." =T DF:d:al-J-uali: Arveriiserent
Ounivar=itySchool [J®oogle Baarch [OT=LK Program CJourrant/ Pravious EPIK Teachar]s)

* QUEBTIDONMAIRE

How did you learn about the ERIE Program? Belact as many a3 spplicable.

EPIK Homepepe EPIK e—Prezs Friend’ Family Fecebook Advertise|
Univers|ty/ Bohoaol jcogle Search [TELK Program Cumrent’ Frevious EPIK Te
EFL/ESL Inziube FFRecruliment Agency NEew3paper Korean Oonaulgates Em

Bloga ICnline Fonum ¥ ouuDE CHher

REVIEW ONCE MORE
WHEN COMPLETED APPLI-
CATION IS PRODUCED
(AFTER ‘PROCEED’)




E@ EP‘K Guest EI'IinSh TE.'HEhEI' RBCI'I.IitiI'Ig HWANG HEEJUN Welcoms Changs Pasaweord | Sign Out

Begin Your Application Rewiew and Pant Your Application

LESSON PLAN

* Grada Lewval Changan by

ottt S FILL IN LESSON
# of Jwdants k< 4 P L Q N a S
* Laa=son Topic H
“ Pravious Dlass -« Domplataly 6l the space provided beloe wp to the word || I N S I R' " : I E D
*

Nullam vites salliciiudin anie. Mulla sempar quis magna au samper. Pressant alit =em,
m, guis egastas srcu tincicunt guis. Pha=ellus congua wites nequa non lobortis. Vestbuly
ia g=t Moroi auctor ac alit a alemerntum. Quisgue maximus rague non sahicula pallarios; ‘ : I R I A I N I I I I R I
nisger e orbor eroa. Donec in jusio dapibus eros condimanum acelerisgue non witas nis fe
mantum, maleauada dui =ed, imculias diam. Su=pandin=se veabbulum aros et ulicies aod AI = I N O I YI O: ;

ommado guam & Cornmechetur massa. Vestibulum ulriccs varius porte. Donec istoue b ti

n

bulum ultricas erat at lactus cursus, ot sliquat lorem dichem. Mauris impardiet lacinia saple—- — - — —

s condimenium ana ulrices non. Proin eget libero vel eat pallente=gue =u=cipit Infaper Tingilla srat & rhomncus natrum

“ Additional Handouts = Domplataly Gl tha space provided balow up to the waord lirmit] 200)

MNullam viles sallicitudin ante. Mulla sempsr Qui= magna au =amper. Prea=ant olit =em, uclu= vikse mi a, sgastas Srmantum ma==a. Mascenas molii= aleiond lorem, o
uis epesias arcu tincidunt quis. Pha=sellus congue vies nequa non loborti=. Veatbulum uma mi, condimentum ac enim &k, rerum ultices arcs. Gad =it amet molli=s ast
Merbl aucior ac efit @ slemantum. Cuisque maximus negue non vehicula pellaniesqus.

nbe-ger ot bortor gros. Donac in jusis dapibus eros condimartum scelarisque non witas nial. Maorbi ac &lis samper, shifend alit vilss, mpendie! metus. Bed aged cdio fem
arum, malesuada dui sed, iaculi= diam. Bu=spandizas vastbulum arcs ot ulricies sooales. Donac bibsndwm, nilbh in mollis placerat, @ros ex wlfricss libare, spat comimr
odo ouam & Commecietur masaa. Westbulum ulrices varivs porta. Donec tistious bibendum velit, guis sodales e=tlabarfs at Buspendis=e vel sros ante. Vestbulum ukt
rices arat ef lectus cursu=, ut aliguet lorem dictum. Mauris imperdist lacinia =agitfs. Donec lacinia guam at laomeat incidund. Cra= iaculis varus lecus, vanius condimant
um anke ulnce= non. Proin ages libearo wal a=t pellantasqua auscipi. neger fingilla anat a honcus rufrem.

Wivamus su magna auismad, vulputste libers au, samper ma==sa. Moacenas jusio medus, Handit ac ristigue =ed, |obars= =it amet mi. Nullam commeade, alit =ed

Fila Linload

+ iom Wnina e REVIEW WHEN
e COMPLETED APPLICA-

Objective TION IS PRODUCED
“By e and o i class smiens wit e etie w: -0y wive s (AFTER ‘PROCEED”)

By tha and of this clas= =tudents will ba able ...

Nullam vima sollicitudin ante. Mula sempar guis magna au =amper. Pres=ant olit =em, ucl= vitse mi a, agastEs Srmantum ma==a. Mascenas molii= aleiend lorem, o
uis epesias arcu tincidunt quis. Pha=sellus congue vies negqua non loborti=. Veatbulum uma mi, condimentum ec enim &k, rerum ultices aros. Gad =it amet molli=s ast
Merbl aucior ac efit 2 slemantum. Quisqua maximues negue mon vehicula pellantesqus.

nbe-ger ot bortor groa. Donec in jusis dapibus eros condimartum scelarisque non witas nial. Maorbi ac &lis samper, shifend clit vilee, mpendie! metus. Bed aged cdio fem
artum, malesuada dui sed, iaculi= diam. Buspandizas vastbulum arcs ot ulricies sooales. Donac bibsndwm, nilbh in maollis placerat, @ros ex wlfricss libare, apat comimr
odo guam ex commecietur masaa. Westbulum ulrices varivs porta. Donec tistigus bibendum velit, guis sodales estlabaris at Buspendis=e vel sroa ante. Vestbulum ult
rices arat ef lectus cursu=, ut aliguet lorem dictum. Mauris imperdist lacinia =agitfs. Donec lacinia guam at laomeat incidund. Cra= iaculis varus lecus, vanius condimand
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gue, ac facilisis diam,
In eget velit nulla, Fusce efficitur tortor quis im perdiet hendrerit, &enean porta sapien non lectus placerat ulrices, Nunc non ullamcorper magna, Mauris witae rutrum m

etus, Munc ac,
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Hullam sdtae sollicitudin ante. Mulla semper quis magna eu semper, Pragsent elit sem, luctus vitae mi a, egestas fermentum massa. Maecenas mollis eleifend lore
m, quis egestas arcu tincidunt quis, Phasellus congue witae neqgue non lobortis, Westbulum urma mi, condimentum ac enim at, rutrum ulrices eros, Sed sit amet moll
iz est, Morbi auctor ac elit a elementum , GQuisgue maximus negue non wehicula pellentesque,

Integer et tortar eros, Donec in justo dapibus eros condimentum scelerisgue non witae nisl, Morbi ac felis semper, eleifend elit vitae, imperdiet metus, Sed eget odio fe
rmentum, malesuada dui sed, iaculis diam, Suspendisse vestibulum eros et ultricies sodales, Donec hibendum, nibh in mollis placerat, eros ex ultrices libero, eget ¢
ommodo quam ex consectetur massa, Yestbulum ultices warius porta, Donec fristigue bibendum welit, quis sodales est lobortis at, Suspendisse vel eros ante, Mulla
m witae sollicitudin ante, Mulla semper quis magna e semper, Praesent elit sem, luctus vitae mi a, egestas fermentum massa, Maecenas maollis eleifend lorem, qui
s edestas arcu tincidunt quis, Phasellus congue witae negue non loboris, Vestibulum urna mi, condimentum ac enim at, rutum ultrices eros, Sed sitamet mollis es

t, Morbi auctor ac elit a elementum, Guisgue maximus negue non vehicula pellentesque,

Inteaer et totor eros Donec in st danibis eros condim enim scelerisane non sitae nisl borbi ac felis spmoer. eleifend elit vitae . im oerdiet meh) ed eaet odio fe
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